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PREFACE

Thank you for purchasing the ADSP-BF561 EZ-KIT Lite®, Analog

Devices, Inc. evaluation system for Blackfin® processors.

Blackfin processors embody a type of embedded processor designed specif-
ically to meet the computational demands and power constraints of
today’s embedded audio, video, and communications applications. They
deliver breakthrough signal-processing performance and power efficiency
within a reduced instruction set computing (RISC) programming model.

Blackfin processors support a media instruction set computing (MISC)
architecture. This architecture is the natural merging of RISC, media
functions, and digital signal processing (DSP) characteristics. Blackfin
processors deliver signal-processing performance in a microprocessor-like
environment.

Based on the Micro Signal Architecture (MSA), Blackfin processors com-
bine a 32-bit RISC instruction set, dual 16-bit multiply accumulate
(MAC) DSP functionality, and eight-bit video processing performance
that had previously been the exclusive domain of very-long instruction

word (VLIW) media processors.
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The evaluation board is designed to be used in conjunction with the
CrossCore® Embedded Studio (CCES) and VisualDSP++® development
environments to test the capabilities of the ADSP-BF561 Blackfin proces-
sors. The VisualDSP++ development environment gives you the ability to
perform advanced application code development and debug, such as:

* Create, compile, assemble, and link application programs written

in C++, C, and ADSP-BF561 assembly
* Load, run, step, halt, and set breakpoints in application programs
* Read and write data and program memory
* Read and write core and peripheral registers
* Plot memory

Access to the ADSP-BF561 processor from a personal computer (PC) is
achieved through a USB port or an optional JTAG emulator. The USB
interface gives unrestricted access to the ADSP-BF561 processor and the
evaluation board peripherals. Analog Devices JTAG emulators offer faster
communication between the host PC and target hardware. Analog Devices
carries a wide range of in-circuit emulation products. To learn more about
Analog Devices emulators and processor development tools, go to
http://www.analog.com/dsp/tools.

The ADSP-BF561 EZ-KIT Lite provides example programs to demon-
strate the capabilities of the evaluation board.

ADSP-BF561 EZ-KIT Lite Evaluation System Manual
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Product Overview

The board features:
* Analog Devices ADSP-BF561 Blackfin processor
e 256-pin mini-BGA package
* 30 MHz CLKIN oscillator
* Synchronous dynamic random access memory (SDRAM)
* 64 MB (16M x 16 bits x 2 chips)
* Flash memory
e 8 MB (4M x 16 bits)
* Analog audio interface
e AD1836 A — Analog Devices 96 kHz audio codec
* 4 input RCA phono jacks (2 stereo channels)
* 6 output RCA phono jacks (3 stereo channels)
* Analog video interface
* ADV7183A video decoder w/ 3 input RCA phono jacks
e ADV7179 video encoder w/ 3 output RCA phono jacks
* Universal asynchronous receiver/transmitter (UART)
* ADM3202 RS-232 line driver/receiver

¢ DB9 male connector

ADSP-BF561 EZ-KIT Lite Evaluation System Manual
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Product Overview

e LEDs

* 20 LEDs: 1 power (green), 1 board reset (red), 1 USB (red),
16 general-purpose (amber), and 1 USB monitor (amber)

e Push buttons

* 5 push buttons with debounce logic: 1 reset,
4 programmable flags

* Expansion interface

e ppIO0, PPI1, SPI, EBIU, Timers11-0, UART,
programmable flags, SPORTO, SPORT1

e Other features
* JTAG ICE 14-pin header
The EZ-KIT Lite board holds 8 MB of flash memory, which can be used

to store user-specific boot code, allowing the board to run as a stand-alone
unit. The board also holds 512-Mb SDRAM, which can be used at run-

time. For more information see “Memory Map” on page 1-11.

SPORTO interfaces with the AD18306A audio codec, facilitating creation of
audio signal processing applications. SPORTO also attaches to an off-board

connector to allow communication with other serial devices. For informa-
tion about SPORTO, see “SPORT Audio Interface” on page 2-3.

The parallel peripheral interfaces (PPIs) of the processor connect to both a
video encoder and video decoder, facilitating creation of video signal pro-
cessing applications. For information on how the board utilizes the
processor’s PPIs, see “PPI Interfaces” on page 2-5.

The UART of the processor connects to an RS-232 line driver and a DB9
male connector, allowing you to interface with a PC or other serial device.

For information about the UART, see “UART Port” on page 2-8.

Xil
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Preface

Additionally, the EZ-KIT Lite board provides access to most of the pro-
cessor’s peripheral ports. Access is provided in the form of a
three-connector expansion interface. For information about the expansion
interface, see “Expansion Interface” on page 2-8.

Purpose of This Manual

The ADSP-BF561 EZ-KIT Lite Evaluation System Manual provides
instructions for installing the product hardware (board). The text
describes operation and configuration of the board components and pro-
vides guidelines for running your own code on the ADSP-BF561 EZ-KIT
Lite. Finally, a schematic and a bill of materials are provided as a reference
for future designs.

Intended Audience

The primary audience for this manual is a programmer who is familiar
with Analog Devices processors. This manual assumes that the audience
has a working knowledge of the appropriate processor architecture and
instruction set.

Programmers who are unfamiliar with Analog Devices processors can use
this manual but should supplement it with other texts that describe your
target architecture. For the locations of these documents, see “Related
Documents”.

Programmers who are unfamiliar with CCES or Visual DSP++ should refer
to the online help and user’s manuals.
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Manual Contents

Manual Contents

The manual consists of:

Chapter 1, “Using the ADSP-BF561 EZ-KIT Lite” on page 1-1
Describes the EZ-KIT Lite functionality from a programmer’s per-
spective and provides an easy-to-access memory map

Chapter 2, “ADSP-BF561 EZ-KIT Lite Hardware Reference” on
page 2-1
Provides information on the EZ-KIT Lite hardware components.

Appendix A, “ADSP-BF561 EZ-KIT Lite Bill Of Materials” on
page A-1
Provides a list of components used to manufacture the EZ-KIT

Lite board.

Appendix B, “ADSP-BF561 EZ-KIT Lite Schematic” on page B-1
Provides the resources to allow EZ-KIT Lite board-level debugging
or to use as a reference design. Appendix B is part of the online

help.

What's New in This Manual

This is revision 3.3 of the ADSP-BF561 EZ-KIT Lite Evaluation System

Manual. The manual has been updated to include CCES information. In

addition, modifications and corrections based on errata reports against the
previous manual revision have been made.

For the latest version of this manual, please refer to the Analog Devices
Web site.

X1V

ADSP-BF561 EZ-KIT Lite Evaluation System Manual



Preface

Technical Support

You can reach Analog Devices processors and DSP technical support in
the following ways:

Post your questions in the processors and DSP support community
at EngineerZone™:
http://ez.analog.com/community/dsp

Submit your questions to technical support directly at:
http://www.analog.com/support

E-mail your questions about processors, DSPs, and tools develop-
ment software from CrossCore Embedded Studio or

VisualDSP++:

Choose Help > Email Support. This creates an e-mail to
processor.tools.support@analog.com and automatically attaches
your CrossCore Embedded Studio or Visual DSP++ version infor-
mation and Ticense.dat file.

E-mail your questions about processors and processor applications
to:

processor.support@analog.com or

processor.china@analog.com (Greater China support)

In the USA only, call 1-800-ANALOGD (1-800-262-5643)

Contact your Analog Devices sales office or authorized distributor.
Locate one at:
www.analog.com/adi-sales

ADSP-BF561 EZ-KIT Lite Evaluation System Manual XV



Supported Processors

* Send questions by mail to:
Processors and DSP Technical Support
Analog Devices, Inc.
Three Technology Way
P.O. Box 9106
Norwood, MA 02062-9106
USA

Supported Processors

This evaluation system supports Analog Devices ADSP-BF561 Blackfin
embedded processors.

Product Information

Product information can be obtained from the Analog Devices Web site
and the online help system.

Analog Devices Web Site

The Analog Devices Web site, www.analog.com, provides information
about a broad range of products—analog integrated circuits, amplifiers,
converters, and digital signal processors.

To access a complete technical library for each processor family, go to
http://www.analog.com/processors/technical_library. The manuals
selection opens a list of current manuals related to the product as well as a
link to the previous revisions of the manuals. When locating your manual
title, note a possible errata check mark next to the title that leads to the
current correction report against the manual.

Also note, myAnalog is a free feature of the Analog Devices Web site that
allows customization of a Web page to display only the latest information

xvi
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about products you are interested in. You can choose to receive weekly
e-mail notifications containing updates to the Web pages that meet your
interests, including documentation errata against all manuals.

myAnalog provides access to books, application notes, data sheets, code
examples, and more.

Visit myAnalog (found on the Analog Devices home page) to sign up. If
you are a registered user, just log on. Your user name is your e-mail

address.

EngineerZone

EngineerZone is a technical support forum from Analog Devices. It allows
you direct access to ADI technical support engineers. You can search
FAQs and technical information to get quick answers to your embedded
processing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar
design challenges. You can also use this open forum to share knowledge
and collaborate with the ADI support team and your peers. Visit
http://ez.analog.com to sign up.

ADSP-BF561 EZ-KIT Lite Evaluation System Manual xXvii



Related Documents

Related Documents

For additional information about the product, refer to the following
publications.

Table 1. Related Processor Publications

Title

Description

ADSP-BF561 Blackfin Embedded Symmetric
Multiprocessor Data Sheet

ADSP-BF561 Blackfin Processor Hardware
Reference

General functional description, pinout, and
timing of the processor

Description of the internal processor archi-
tecture and all register functions

Blackfin Processor Programming Reference Description of all allowed processor assembly

instructions

Notation Conventions

Text conventions used in this manual are identified and described as
follows.

Example Description

Close command

Titles in reference sections indicate the location of an item within the
(File menu)

development environment’s menu system (for example, the Close com-
mand appears on the File menu).

{this | that}) Alternative required items in syntax descriptions appear within curly

brackets and separated by vertical bars; read the example as this or
that. One or the other is required.

[this | that] Optional items in syntax descriptions appear within brackets and sepa-

rated by vertical bars; read the example as an optional this or that.

[this,..] Optional item lists in syntax descriptions appear within brackets delim-
ited by commas and terminated with an ellipse; read the example as an
optional comma-separated list of this.

.SECTION

Commands, directives, keywords, and feature names are in text with
letter gothic font.
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Example

Description

filename

Non-keyword placeholders appear in text with italic style format.

Note: For correct operation, ...
A Note provides supplementary information on a related topic. In the
online version of this book, the word Note appears instead of this

symbol.

®
N

Caution: Incorrect device operation may result if ...

Caution: Device damage may result if ...

A Caution identifies conditions or inappropriate usage of the product

that could lead to undesirable results or product damage. In the online
version of this book, the word Caution appears instead of this symbol.

O

Warning: Injury to device users may result if ...

A Warning identifies conditions or inappropriate usage of the product
that could lead to conditions that are potentially hazardous for the
devices users. In the online version of this book, the word Warning
appears instead of this symbol.

ADSP-BF561 EZ-KIT Lite Evaluation System Manual XX
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1 USING THE ADSP-BF561
EZ-KIT LITE

This chapter provides specific information to assist you with development
of programs for the ADSP-BF561 EZ-KIT Lite evaluation system.

The information appears in the following sections.

“Package Contents” on page 1-2
Lists the items contained in your ADSP-BF561 EZ-KIT Lite
package.

“Default Configuration” on page 1-3
Shows the default configuration of the ADSP-BF561 EZ-KIT Lite.

“CCES Install and Session Startup” on page 1-4
Instructs how to start a new or open an existing

ADSP-BF561EZ-KIT Lite session using CCES.

“VisualDSP++ Install and Session Startup” on page 1-8
Instructs how to start a new or open an existing

ADSP-BF561EZ-KIT Lite session using VisualDSP++.

“CCES Evaluation License” on page 1-10
Describes the CCES demo license shipped with the EZ-KIT Lite.

“Visual DSP++ Evaluation License” on page 1-11
Describes the Visual DSP++ demo license shipped with the EZ-KIT
Lite.

“Memory Map” on page 1-11
Defines the ADSP-BF561 EZ-KIT Lite’s external memory map.

ADSP-BF561 EZ-KIT Lite Evaluation System Manual 1-1



Package Contents

e “LEDs and Push Buttons” on page 1-14-
Describes the board’s LEDs and push buttons.

e “Audio Interface” on page 1-15
Describes the board’s audio interface.

* “Video Interface” on page 1-16
Describes the board’s video interface.

* “Board Design Database” on page 1-17
Describes the board design.

e “Example Programs” on page 1-18
Provides information about the example programs included in the
ADSP-BF561 EZ-KIT Lite evaluation system.

e “Flash Programming Utility” on page 1-18
Highlights the advantages of the Flash Programmer utility.

For information on the graphical user interface, including the boot load-
ing, target options, and other facilities of the EZ-KIT Lite system, refer to
the online help.

For more detailed information about the ADSP-BF561 Blackfin proces-
sor, see the documents referred to at “Related Documents”.

Package Contents

Your ADSP-BF561 EZ-KIT Lite evaluation system package contains the
following items.

* ADSP-BF561 EZ-KIT Lite board
* Universal 7V DC power supply
e USB 2.0 cable

1-2
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Using the ADSP-BF561 EZ-KIT Lite

If any item is missing, contact the vendor where you purchased your
EZ-KIT Lite or contact Analog Devices, Inc.

Default Configuration

The EZ-KIT Lite evaluation system contains ESD (electrostatic

discharge) sensitive devices. Electrostatic charges readily accumu-

late on the human body and equipment and can discharge without ‘
detection. Permanent damage may occur on devices subjected to

high-energy discharges. Proper ESD precautions are reccommended ‘E'\
to avoid performance degradation or loss of functionality. Store

unused EZ-KIT Lite boards in the protective shipping package.

The ADSP-BF561 EZ-KIT Lite board is designed to run outside your per-
sonal computer as a standalone unit. You do not have to open your
computer case.

When removing the EZ-KIT Lite board from the package, handle the
board carefully to avoid the discharge of static electricity, which may
damage some components. Figure 1-1 shows the default jumper settings,
DIP switch, connector locations, and LEDs used in installation. Confirm
that your board is set up in the default configuration before using the

board.

ADSP-BF561 EZ-KIT Lite Evaluation System Manual 1-3



CCES Install and Session Startup
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Figure 1-1. EZ-KIT Lite Hardware Setup

CCES Install and Session Startup

For information about CCES and to download the software, go to
www.analog.com/CCES. A link for the ADSP-BF561 EZ-KIT Lite Board

Support Package (BSP) for CCES can be found at
http://www.analog.com/Blackfin/EZKits.
Follow these instructions to ensure correct operation of the product soft-

ware and hardware.
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Using the ADSP-BF561 EZ-KIT Lite

Step 1: Connect the EZ-KIT Lite board to a personal computer (PC) run-
ning CCES using one of two options: an Analog Devices emulator or via
the debug agent.

Using an Emulator:

1. Plug one side of the USB cable into the USB connector of the emu-
lator. Plug the other side into a USB port of the PC running
CCES.

2. Attach the emulator to the header connector P4 (labeled JTAG) on
the EZ-KIT Lite board.

Using the on-board Debug Agent:

1. Plug one side of the USB cable into the USB connector of the
debug agent 7J1 (labeled USB).

2. Plug the other side of the cable into a USB port of the PC running
CCES.

Step 2: Attach the provided cord and appropriate plug to the power
adaptor.

1. Plug the jack-end of the power adaptor into the power connector

J7 (labeled Power) on the EZ-KIT Lite board.

2. Plug the other side of the power adaptor into a power outlet. The
power LED (labeled LED1) is lit green when power is applied to the
board.

3. Power the emulator (if used). Plug the jack-end of the assembled
power adaptor into the emulator and plug the other side of the
power adaptor into a power outlet. The enable/power is lit green
when power is applied.

ADSP-BF561 EZ-KIT Lite Evaluation System Manual 1-5



CCES Install and Session Startup

Step 3 (if connected through the debug agent): Verify that the yellow
USB monitor LED (labeled ZLED3) on the debug agent is on. This signifies

that the board is communicating properly with the host PC and ready to
run CCES.

Session Startup

It is assumed that the CrossCore Embedded Studio software is installed
and running on your PC.

Note: If you connect the board or emulator first (before installing
CCES) to the PC, the Windows driver wizard may not find the

board drivers.

1. Navigate to the CCES environment via the Start menu.

Note that CCES is not connected to the target board.

2. Use the system configuration utility to connect to the EZ-KIT Lite
board.

If a debug configuration exists already, select the appropriate
configuration and click Apply and Debug or Debug. Go to step 8.

To create a debug configuration, do one of the following:

* Click the down arrow next to the little bug icon, select
Debug Configurations

* Choose Run > Debug Configurations.
The Debug Configuration dialog box appears.
3. Select CrossCore Embedded Studio Application and click | 7|

(New launch configuration).

The Select Processor page of the Session Wizard appears.

1-6 ADSP-BF561 EZ-KIT Lite Evaluation System Manual



Using the ADSP-BF561 EZ-KIT Lite

4. Ensure Blackfin is selected in Processor family. In Processor type,

select ADSP-BF561. Click Next.

The Select Connection Type page of the Session Wizard appears.
5. Select one of the following:

* For standalone debug agent connections, EZ-KIT Lite and
click Next.

¢ For emulator connections, Emulator and click Next.
The Select Platform page of the Session Wizard appears.
6. Do one of the following;:

* For standalone debug agent connections, ensure that the
selected platform is ADSP-BF561 EZ-KIT Lite via Debug
Agent.

* For emulator connections, choose the type of emulator that
is connected to the board.

7. Click Finish to close the wizard.

The new debug configuration is created and added to the pro-
gram(s) to load list.

8. In the Program(s) to load section, choose the program to load
when connecting to the board. If not loading any program upon
connection to the target, do not make any changes.

Note that while connected to the target, there is no way to choose a
program to download. To load a program once connected, termi-
nate the session.
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VisualDSP++ Install and Session Startup

To delete a configuration, go to the Debug Configurations dialog
box and select the configuration to delete. Click x and choose Yes
when asked if you wish to delete the selected launch configuration.

Then Close the dialog box.

To disconnect from the target board, click the terminate button
(red box) or choose Run > Terminate.

To delete a session, choose Target > Session > Session List. Select
the session name from the list and click Delete. Click OK.

VisualDSP++ Install and Session Startup

For information about VisualDSP++ and to download the software, go to
www.analog.com/VisualDSP.

1. Verify that the yellow USB monitor LED (7ZLED3, located near the

USB connector) is lit. This signifies that the board is communicat-
ing properly with the host PC and is ready to run VisualDSP++.

. If you are running Visual DSP++ for the first time, navigate to the

Visual DSP++ environment via the Start > Programs menu. The
main window appears. Note that VisualDSP++ does not connect to
any session. Skip the rest of this step to step 3.

If you have run Visual DSP++ previously, the last opened session
appears on the screen. You can override the default behavior and
force Visual DSP++ to start a new session by pressing and holding
down the Ctrl key while starting VisualDSP++. Do not release the
Ctrl key until the Session Wizard appears on the screen. Go to
step 4.

1-8
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3. To connect to a new EZ-KIT Lite session, start Session Wizard by
selecting one of the following.

¢ From the Session menu, New Session.

¢ From the Session menu, Session List. Then click New Ses-
sion from the Session List dialog box.

¢ From the Session menu, Connect to Target.

4. The Select Processor page of the wizard appears on the screen.
Ensure Blackfin is selected in Processor family. In Choose a target

processor, select ADSP-BF561. Click Next.

5. The Select Connection Type page of the wizard appears on the
screen. Select EZ-KIT Lite and click Next.

6. The Select Platform page of the wizard appears on the screen.
In the Select your platform list, select ADSP-BF561 EZ-KIT Lite
via Debug Agent. In Session name, highlight or specify the session
name.

The session name can be a string of any length; although, the box
displays approximately 32 characters. The session name can
include space characters. If you do not specify a session name,
Visual DSP++ creates a session name by combining the name of the
selected platform with the selected processor. The only way to
change a session name later is to delete the session and to open a
new session.

Click Next.

7. The Finish page of the wizard appears on the screen. The page dis-
plays your selections. If you are satisfied, click Finish. If not, click
Back to make changes.
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To disconnect from a session, click the disconnect button %
or select Session > Disconnect from Target.

To delete a session, select Session > Session List. Select the session

name from the list and click Delete. Click OK.

CCES Evaluation License

The ADSP-BF561 EZ-KIT Lite software is part of the Board Support
Package (BSP) for the Blackfin ADSP-BF56x family. The EZ-KIT Lite is
a licensed product that offers an unrestricted evaluation license for 90 days
after activation. Once the evaluation period ends, the evaluation license
becomes permanently disabled. If the evaluation license is installed but
not activated, it allows 10 days of unrestricted use and then becomes dis-
abled. The license can be re-enabled by activation.

An evaluation license can be upgraded to a full license. Licenses can be
purchased from:

* Analog Devices directly. Call (800) 262-5645 or 781-937-2384 or
go to:
http://www.analog.com/buyonline.

e Analog Devices, Inc. local sales office or authorized distributor. To
locate one, go to:
http://www.analog.com/salesdir/continent.asp.

The EZ-KIT Lite hardware must be connected and powered up to
use CCES with a valid evaluation or full license.
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VisualDSP++ Evaluation License

The ADSP-BF561 EZ-KIT Lite installation is part of the Visual DSP++
installation. The EZ-KIT Lite is a licensed product that offers an unre-
stricted evaluation license for the first 90 days. Once the initial
unrestricted 90-day evaluation license expires:

* VisualDSP++ allows a connection to the ADSP-BF561 EZ-KIT
Lite via the USB Debug Agent interface only. Connections to sim-
ulators and emulation products are no longer allowed.

e The linker restricts a user’s program to 41 KB of memory for code
space with no restrictions for data space.

To avoid errors when opening VisualDSP++, the EZ-KIT Lite
hardware must be connected and powered up. This is true for using
VisualDSP++ with a valid evaluation or full license.

Memory Map

The EZ-KIT Lite board includes two types of external memory, 64-MB
SDRAM and 8-MB flash. See the external memory map in Table 1-1. The

complete configuration of the ADSP-BF561 processor internal SRAM is
detailed in Figure 1-2.

Table 1-1. EZ-KIT Lite External Memory Map

Start Address |End Address  |Description

0x00000000 | Ox3FFFFFF SDRAM bank 0; see “Memory Map” on page 1-11

0x20000000 0x207FFFFF ASYNC memory bank 0; see “Memory Map” on page 1-11.

All other locations Not used
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CORE A MEMORY MAP CORE B MEMORY MAP

OXFFFF FFFF

CORE MMR REGISTERS CORE MMR REGISTERS
OXFFEO 0000 SYSTEM MMR REGISTERS
0XFFCO 0000
0XFFB0 1000 —»{RESERVED

L1 SCRATCHPAD SRAM (4K)
0XFFBO 0000 p———
OXFFA1 4000 —

L1 INSTRUCTION SRAM/CACHE (16K)
OXFFA1 0000 —»

RESERVED
0XFFAO 4000

L1 INSTRUCTION SRAM (16K)
0XFFAQ 0000 P RESERVED
OXFFo0 8000 —w|PESERVED |

L1 DATA BANK B SRAM/CACHE (16K)
0XFF90 4000

L1 DATA BANK B SRAM (16K)
0XFF90 0000 E———
OXFF80 8000

L1 DATA BANK A SRAM/CACHE (16K)
OXFF80 4000

L1 DATA BANK A SRAM (16K)
0XFF80 0000

O0XFF70 1000 —»~|
0XFF70 0000 —»~|

L1 SCRATCHPAD SRAM (4K)

OXFF614000 —» RESERVED
L1 INSTRUCTION SRAM/CACHE (16K)
OXFF610000 —»
OXFF60 4000 —» RESERVED)
L1 INSTRUCTION SRAM (16K)
OXFF60 0000 —» RESERVED
RESERVED

0XFF50 8000 —»~|
0XFF50 4000 —»~|
0XFF50 0000 —»{
0XFF40 8000 —»~|
0XFF40 4000 —»~|

L1 DATA BANK B SRAM/CACHE (16K)
L1 DATA BANK B SRAM (16K)
RESERVED

L1 DATA BANK A SRAM/CACHE (16K)
L1 DATA BANK A SRAM (16K)

OXFF40 0000

OXFEB2 0000 RESERVED
0XFEBO 0000 L2 SRAM (128K)
OXEF00 0800 RESERVED

Figure 1-2. ADSP-BF561 Processor Internal Memory Map

The 8 MB of flash memory is organized as 4M x 16 bit and mapped into a
ADSP-BF561 processor’s ASYNC memory bank 0. The AMSO memory
select signal connects to the output enable pin of flash memory.

The 64 MB of SDRAM is organized as 16M x 32 bits wide. The proces-
sor’s memory select pin SMSO is configured for SDRAM. Three SDRAM
control registers must be initialized in order to access the SDRAM
memory.
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When in a CCES or Visual DSP++ session, you can configure the SDRAM

registers automatically:

e CCES users, choose Target > Settings > Target Options > Use
XML reset values

*  VisualDSP++ users, choose Settings > Target Options > Use XML
reset values

The EBIU_SDGCTL, EBIU_SDBCTL, and EBIU_SDRRC register values have been
set in the ADSP-BF561-proc.xml file found in your System\ArchDef folder.
These values can be changed to be more optimal depending on the SCLK
frequency.

The values in Table 1-2 are set by default whenever bank 0 is accessed
through the debugger (for example, when viewing memory windows or
loading a program). The numbers are derived for maximum flexibility and
work for a system clock frequency between 60 MHz and 133 MHz.

Table 1-2. EZ-KIT Lite Session SDRAM Default Settings

Register Value Function

EBIU_SDGCTL 0x0091998D Calculated with SCLK = 133 MHz
EBIU_SDBCTL 0x00000013

EBIU_SDRRC 0x000001CF Calculated with SCLK = 120 MHz

The EBIU_SDGCTL register can be written once after the processor comes
out of reset. Therefore, the user code should not re-initialize the register.
Clearing the Use XML reset values check box allows manual configura-
tion of the EBIU registers. For more information, see online help.
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Automatic configuration of SDRAM is not optimized for a specific SCLK
frequency. Table 1-3 shows the optimized configuration of the SDRAM
registers using a 120 MHz ScLK. The frequency of 120 MHz is the maxi-
mum SCLK frequency when using a 600 MHz core frequency, the
maximum frequency for the EZ-KIT Lite. Only the EBIU_SDRRC register
needs to be modified in the user code to achieve maximum performance.

Table 1-3. SDRAM Optimum Settings1

Register Value

EBIU_SDGCTL 0x0091998D
EBIU_SDBCTL 0x00000013
EBIU_SDRRC 0x000003A0

1 Calculated with SCLK = 120 MHz

For more information, see “External Bus Interface Unit” on page 2-3.

An example program is included in the EZ-KIT installation direc-
tory to demonstrate the SDRAM interface setup.

LEDs and Push Buttons

The EZ-KIT Lite provides four push buttons and sixteen LEDs for gen-
eral-purpose 10.

Sixteen LEDs, labeled LEDS through LED20, are controlled by the proces-
sor’s programmable flags PF32 through PF47 (equivalent to PP10_D15-8
and PPI1_D15-8). These LEDs are accessed through the FLAG 2 registers.
First, the direction must be configured to output by setting the bits of the
FI02_DIR register to 1. Then the value of the LEDs are modified using one
of the FI02_FLAG_D, FI02_FLAG_C, FI02_FLAG_S, or FI02_FLAG_T registers.

The four general-purpose push buttons are labeled SW6 through sw9. The
buttons connect to the programmable flags PF8-5. A status of each

1-14 ADSP-BF561 EZ-KIT Lite Evaluation System Manual



Using the ADSP-BF561 EZ-KIT Lite

individual button can be read through the FI00_FLAG_D register. A switch
is being pressed-on when the corresponding bit of the register reads 1.
When the switch is released, the bit reads 0. A connection between the
push button and PF input is established through the sw4 DIP switch.

For information on how to disconnect the switch from the programmable

flag and use it for another objective, see “Push Button Enable Switch
(SW4)”.

An example program is included in the EZ-KIT Lite installation
directory to demonstrate functionality of the LEDs and push
buttons.

Audio Interface

The AD1836A audio codec provides three channels of stereo audio output
and two channels of multichannel 96 kHz input. The SPORTO interface of
the processor links with the stereo audio data input and output pins of the
AD1836A codec. The processor is capable of transferring data to the

audio codec in time-division multiplexed (TDM) or 2-wire serial interface

(TWI) mode.

In TWI mode, the codec can operate at a 96 kHz sample rate but restricts
the output to two channels. In TDM mode, the codec can operate at a
maximum of 48 kHz sample rate but allows simultaneous use of all input
and output channels. When using TWI mode, the TSCLK0 and RSCLKO pins
(as well as the TFS0 and RFSO pins of the processor) must be tied together
externally to the processor. This is accomplished with the sw4 DIP switch.
See “Push Button Enable Switch (SW4)” on page 2-12 for more
information.

The AD1836A audio codec’s internal configuration registers are config-
ured using the processor’s PF4 programmable flag pin, used as the select
for the audio device. For more information on how to configure the
multichannel codec, go to www.analog.com/AD1836A.
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The AD1836A codec reset is controlled by the processor’s programmable
flag PF15. When PF15 is 0, the reset is asserted. When PF15 is 1, the reset is
de-asserted. Note that when PF15 is not driven (configured as input), the
AD18306A reset is asserted due to the pull-down resistor. See “Programma-
ble Flags” on page 2-4 for more information.

Example programs are included in the EZ-KIT Lite installation
directory to demonstrate the AD1836A codec operation.

Video Interface

The board supports video input and output applications. The ADV7179
video encoder provides up to three output channels of analog video, while
the ADV7183A video decoder provides up to three input channels of ana-
log video. The video encoder connects to the parallel peripheral

interface 1 (PPI1), while the video decoder connects to the parallel periph-
eral interface 0, (PP10). Each PPI interface has an individual clock that is
configured by the sW5 switch settings. See “PPI Clock Select Switch
(SW5)” on page 2-13 for more information.

Both the encoder and the decoder connect to the parallel peripheral inter-
faces (PPI input clock) of the processor. For additional information on the
video interface hardware, refer to “PPI Interfaces” on page 2-5.

For the video interface to be operational, the following basic steps must be
performed.

1. Configure the SW2 DIP switch as required by the application. Refer
to “Video Configuration Switch (SW2)” on page 2-10 for details.

2. De-assert the video device’s reset by setting high a corresponding
programmable flag. PF14 controls the ADV7179 encoder’s reset,
while PF13 controls the ADV7183A decoder’s reset.
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If using the ADV7183A decoder:

* Enable device by driving programmable flag output PF2 to
0

o Select PP10 clock; for details, refer to “PPI Clock Select
Switch (SW5)” on page 2-13.

Program internal registers of the video device in use. Both video
encoder and decoder use a 2-wire serial interface to access internal
registers. The PF0 programmable flag functions as a serial clock
(scL), and PF1 functions as a serial data (SDAT).

Program the ADSP-BF561 processor’s PPI interfaces (configura-
tion registers, DMA, and so on).

Example programs are included in the EZ-KIT Lite installation
directory to demonstrate the capabilities of the video interface.

Board Design Database

A .zip file containing all of the electronic information required for the
design, layout, fabrication and assembly of the product is available for
download from the Analog Devices board design database at:
http://www.analog.com/board-design-database.
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Example Programs

Example programs are provided with the ADSP-BF561 EZ-KIT Lite to
demonstrate various capabilities of the product. The programs are
included in the product installation kit and can be found in the Examples
folder of the installation. Refer to a readme file provided with each exam-
ple for more information.

CCES users are encouraged to use the example browser to find examples

included with the EZ-KIT Lite Board Support Package.

Flash Programming Utility

The ADSP-BF561 EZ-KIT Lite evaluation system includes a flash pro-
gramming utility. The utility allows you to program flash memory on the
EZ-KIT Lite. The utility installed with VisualDSP++ is called Flash Pro-
grammer. The utility installed with CCES is called Device Programmer.

The flash programming driver is core-specific (core A) and must be loaded
to core A in order to operate correctly. The flash programming utility
relies on the user to set the correct core focus. To set the correct core,
select core A in the multiprocessor window before opening the utility
interface.

For more information on the flash programming utility, refer to the
online help.
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2 ADSP-BF561 EZ-KIT LITE
HARDWARE REFERENCE

This chapter describes the hardware design of the ADSP-BF561 EZ-KIT

Lite board. The following topics are covered.

“System Architecture” on page 2-2
Describes the ADSP-BF561 EZ-KIT Lite configuration and

explains how the board components interface with the processor.

“Jumper and DIP Switch Settings” on page 2-10
Shows the locations and describes the configuration jumpers and
switches.

“LEDs and Push Buttons” on page 2-15
Shows the locations and describes the LEDs and push buttons.

“Connectors” on page 2-18

Shows the locations and provides part numbers for the on-board
connectors. In addition, the manufacturer and part number infor-
mation is provided for the mating parts.
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System Architecture

This section describes the processor’s configuration on the EZ-KIT Lite

board.

SDRAM FLASH ADSP-BF 561
Expansion INTERFACES:
16Mx32 AMx16 Connectors (3) [ _GPIO
-PPI
A A A " SPORT
-sPI
- A 4 h 4 s 4 . -etc.
< 'y >
\ 4
JTAG Header |q——p| JTAG PORT | | EBUI | MISC CONTROL:

- AD1836 Reset
- ADV7183A Reset
- ADV7179 Reset
- etc.
ADSP-BF561
0sc o pLL Processor
30MHz L

Clock

PPI 0OSC
Clock
= Clock [*7 27MHz
| UART || sPI || SPORT 0 | ‘ SPORT 1 ‘ | PRIPF || PPRIPF ‘
A ]
- | »
- L J L | LEDs
Ll
AV A3V ALBV 33V h 4 h 4 To B h 4
ADMa202 AD18% ADV7183A |[ ADV7179
RS232 ADtode Videa Videa
= TX/RX Dacoder Encodear
=
> 8 F 3 F 3
q &
CONN
¥ § h 4 h 4
& RS Stareo In Stereo Out Video IN Video OUT
DBY Mate Phono Phono Phona Phono
Jacks (4] | | Jacks () Jacks (3) || Jacks(3)

Figure 2-1. System Architecture

This EZ-KIT Lite has been designed to demonstrate the capabilities of the
ADSP-BF561 Blackfin processor. The processor has an 1O voltage of
3.3V. The core voltage and the core clock rate can be set on the fly by the
processor. The input clock is 30 MHz.
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External Bus Interface Unit

The external bus interface unit (EBIU) connects external memory to the
ADSP-BF561 processor. It includes a 32-bit wide data bus, an address bus
(A25-2), and a control bus. All of the 8-bit, 16-bit, and 32-bit accesses are
supported. On the EZ-KIT Lite board, the EBI unit connects to SDRAM
and flash memory. For more information on using the external memory
see “Memory Map” on page 1-11.

All of the address, data, and control signals are available externally via the
expansion interface connectors (J1-3). The pinout of these connectors can

be found in “ADSP-BF561 EZ-KIT Lite Schematic” on page B-1.

SPORT Avudio Interface

The SPORTO interface connects to the AD1836A audio codec and the
expansion interface. The AD1836A codec uses both the primary and sec-
ondary data transmit and receive pins to input and output data from the
audio input and outputs.

The SPORT1 interface connects to the SPORT connector (P3).

The pinout of the SPORT and expansion interface connectors can be found

in “ADSP-BF561 EZ-KIT Lite Schematic” on page B-1.

SPI Interface

The processor’s serial peripheral interface (SPI) connects to the AD1836A
audio codec and the expansion interface. The SPI connection to the
AD1836A codec is used to access the control registers of the device. The
PF4 flag of the processor acts as the device select for the SPI port.

The SPI signals are available on the expansion interface and on the SPI
connector (P5). The pinout for the interface can be found in

“ADSP-BF561 EZ-KIT Lite Schematic” on page B-1.
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Programmable Flags

The processor has 48 programmable flag pins (PFs). Many of the flags are
multi-functional and depend on the processor’s setup. Table 2-1 shows
how the programmable flag pins are used on the EZ-KIT Lite.

Table 2-1. Programmable Flag Connections

Processor PF Pin

Processor Function

EZ-KIT Lite Function

PFO

SPI select S, timer 0

Serial clock for programming ADV7179 video
encoder and ADV7183A video decoder.

SPI select 1, timer 1

Serial data for programming ADV7179 video encoder
and ADV7183A video decoder.

SPI select 2, timer 2

ADV7183A video decoder’s OE.

SPI select 3, timer 3

ADV7183A FIELD pin. See “Video Configuration
Switch (SW2)” on page 2-10.

SPI select 4, timer 4

AD1836A audio codec’s SPI select.

SPI select 5, timer 5

Push button (SW6). See “LEDs and Push Buttons” on
page 1-14 and “Push Button Enable Switch (SW4)”
on page 2-12 for information on how to disable the
push button.

SPI select 6, timer 6

Push button (SW7). See “LEDs and Push Buttons” on
page 1-14 and “Push Button Enable Switch (SW4)”
on page 2-12 for information on how to disable the
push button.

SPI select 7, timer 7

Push button (SW8). See “LEDs and Push Buttons” on
page 1-14 and “Push Button Enable Switch (SW4)”
on page 2-12 for information on how to disable the
push button.

PF8

Push button (SW9). See “LEDs and Push Buttons”
on page 1-14 and “Push Button Enable Switch
(SW4)” on page 2-12 for information on how to dis-
able the push button.

PF9-12

Not used

PF13

ADV7183A video decoder’s reset

2-4
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Table 2-1. Programmable Flag Connections (Cont'd)

Processor PF Pin |Processor Function  |EZ-KIT Lite Function

PF14 ADV7179 video encoder’s reset
PF15 AD1836 codec’s reset

PF16 SPORTO transmit frame sync pin
PF17 SPORTO transmit data secondary pin
PF18 SPORTO transmit data primary pin
PF19 SPORTO receive frame sync pin
PF20 SPORTO receive data secondary pin
PF21 SPORT1 transmit frame pin

PF22 SPORT1 transmit data secondary pin
PF23 SPORT1 transmit data primary pin
PF24 SPORT1 receive frame sync pin
PF25 SPORT1 receive data secondary pin
PF26 UART transmit pin

PF27 UART receive pin

PF28 SPORTO receive serial clock pin
PF29 SPORTO transmit serial clock pin
PF30 SPORT1 receive serial clock pin
PF31 SPORTI transmit serial clock pin
PF39-32 PPI1 data 15-8 LED13-20

PF47-40 PPI0 data 15-8 LED5-12

PPI Interfaces

The ADSP-BF561 processor employs two independent parallel peripheral
interfaces (PPIs), PP10 and PPI1. Each PPI interface is a half-duplex,
bi-directional bus consisting of 16 bits of data, a dedicated input clock,
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and synchronization signals. The ADSP-BF561 EZ-KIT Lite board uti-
lizes the PPI interfaces for video input and video output.

The PPI0 interface is configured to input video data from the ADV7183A
video decoder device: bits 7-0 connect to the video decoder’s data outputs.
The PP11 interface is configured to output video data to the ADV7179

video encoder device: bits 7-0 connect to the video encoder’s data inputs.

Each PPI interface has a dedicated clock input configured independently
by the Sw5 switch. The clock source can be one of the following: 27 MHz
crystal oscillator, ADV7183A video decoder’s clock output, or external
clock from the expansion interface. See “PPI Clock Select Switch (SW5)”
on page 2-13 for more information about the switch.

The sw2 switch provides a flexible connection between dedicated synchro-
nization 1Os (SYNC1 and SYNC2 of each PPI interface) and the encoder’s
and decoder’s horizontal and vertical synchronization pins. See “Video
Configuration Switch (SW2)” on page 2-10 for more information about
the switch. For a detailed description of the ADSP-BF561 processor’s PPI
interfaces, refer to the ADSP-BF561 Blackfin Processor Hardware Reference.

Table 2-2 describes the PPI pins of the EZ-KIT Lite board.

Table 2-2. PPI Connections

Processor PPI Pin  |Other Processor EZ-KIT Lite Function
Function

PPIO bits 7-0 ADV7183A data outputs P15-8

PPI1 bits 7-0 ADV7179 data inputs P7-0

PPIO SYNC1 Timer 8 ADV7179 HSYNC. For more information, see “Video
Configuration Switch (SW2)” on page 2-10.

PPIO SYNC?2 Timer 9 ADV7179 VSYNC. For more information, see “Video
Configuration Switch (SW2)” on page 2-10.

PPIO clock A choice of ADV7183A output clock, a local
27 MHz oscillator, or an external clock from
ADSP-BF533/BF561 Blackfin EZ-Extender®.
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Table 2-2. PPI Connections (Cont’d)

Processor PPI Pin  |Other Processor EZ-KIT Lite Function

Function
PPI1 SYNC1 Timer 10 ADV7183A HSYNC. For more information, see
“Video Configuration Switch (SW2)” on page 2-10.
PPI1 SYNC2 Timer 11 ADV7183A VSYNC. For more information, see

“Video Configuration Switch (SW2)” on page 2-10.

PPI1 clock A choice of ADV7183A output clock, a local

27 MHzoscillator,oranexternal clockfrom
ADSP-BF53x/BF561 Blackfin EZ-Extender.

Video Output (PPIT)

The PPI1 interface is configured as output and connects to the on-board
video encoder device, ADV7179. The ADV7179 encoder generates three
analog video channels on DAC A, DAC B, and DAC C. The PPI1 bits 7-0 con-
nect to P7-0 of the encoder’s pixel inputs. The encoder’s input clock is
fixed and comes from an on-board 27 MHz oscillator.

The encoder’s synchronization signals, HSYNC and VSYNC, can be config-
ured as inputs or outputs. Video blanking control signal is at level 1. The
HSYNC and VSYNC signals can connect to SYNC1 and SYNC2 of the processor’s

PPI1 interface via the SW2 switch, as described in “Video Configuration
Switch (SW2)” on page 2-10.

Video Input (PPIO)

The PPI0 interface is configured as input and connects to the on-board
video decoder device, ADV7183A. The ADV7183A decoder receives three
analog video channels on AIN1, AIN4, and AINS input. The decoder’s pixel
data outputs P15-8 drive the PP10 inputs 8-0. The decoder’s 27 MHz pixel
clock output can be selected to drive any of the PPI clocks as shown in

Table 2-7 on page 2-13.
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Synchronization outputs of the decoder, HS/HACTIVE, VS/VACTIVE, and
FIELD can connect to the processor’s PPI0_SYNC1, PPIO_SYNC2, and PF3

flag via the sW2 DIP switch, as described in “Video Configuration Switch
(SW2)” on page 2-10.

UART Port

The processor’s universal asynchronous receiver/transmitter (UART) port
connects to the ADM3202 RS-232 line driver as well as to the expansion
interface. The RS-232 line driver is attached to the DB9 male connector,
providing an interface to a personal computer and other serial devices.

Expansion Interface

The expansion interface consists of the three 90-pin connectors, J1-3.
Table 2-3 shows the interfaces each connector provides. For the exact pin-
out of the connectors, refer to “ADSP-BF561 EZ-KIT Lite Schematic” on

page B-1. The mechanical dimensions of the connectors can be obtained
from Technical Support.

Table 2-3. Connector Interfaces

Connector |Interfaces

J1 5V, GND, address, data, PPI0 3-0, PF15-6, PF4
Jz2

3.3V, GND, SPI, NMI, PPI0 SYNC3-1, SPORTO, SPORT1, PF15-0, EBUI control sig-
nals

J3

5V, 3.3V, GND, UART, PPI1 15-0, reset, video control signals
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Limits to the current and to the interface speed must be taken into consid-
eration when using the expansion interface. The maximum current limit is
dependent on the capabilities of the used regulator. Additional circuitry
also can add extra loading to signals, decreasing their maximum effective

speed.

Analog Devices does not support and is not responsible for the
effects of additional circuitry.

JTAG Emulation Port

The JTAG emulation port allows an emulator to access internal and exter-
nal memories of the processor through a 6-pin interface. The JTAG
emulation port of the processor also connects to the USB debugging inter-
face. When an emulator connects to the board at ZP4, the USB debugging
interface is disabled. See “JTAG (ZP4)” on page 2-22 for more informa-
tion about the JTAG connector.

To learn more about available emulators, go to
http://www.analog.com/processors/tools/blackfin.
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Jumper and DIP Switch Settings

Jumper and DIP Switch Settings

This section describes functionality of the jumpers and DIP switches. The
jumper and DIP switch locations are shown in Figure 2-2.
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PART NUMBER: ADZS-BFS61~EZLITE
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DESIGNED BY ANALOG DEVICES INC.
ANALOG
DEVICES

Figure 2-2. DIP Switch Locations

Video Configuration Switch (SW2)

The video configuration switch (SW2) determines how some video signals
from the ADV7183A video decoder and ADV7179 video encoder are
routed to the processor’s PPIs. The switch also determines if the PF2 pin

controls the OF signal of the ADV7183A video decoder outputs. See
Table 2-4.
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Table 2-4. Video Configuration Switch (SW2)

ADSP-BF561 EZ-KIT Lite Hardware Reference

Switch Position (Default) Processor Signal Video Signal
1 (OFF) PPI1 SYNCI ADV7179

2 (OFF) PPI0 SYNCI ADV7183A
3 (0FF) PPI1 SYNC2 ADV7183A
4 (OFF) PPI1 SYNC2 ADV7179

5 (OFF) PF3 (FIELD) ADV7183A
6 (ON) PF2 ADV7183A

Positions 1 thorough 5 of SW2 determine how and if the SYNC1, SYNC2, and
FIELD control signals of the PP10 and PPI1 interfaces are routed to the pro-
cessor’s PPIs. In standard configuration of the encoder and decoder, this is
not necessary because the processor is capable of reading the control infor-
mation embedded in the data stream.

Position 6 of SW2 determines whether PF2 connects to the 0F signal of the
ADV7183A device. When the switch is OFF, PF2 can be used for other
operations, and the decoder output enable is held high with a pull-up

resistor.

Boot Mode Switch (SW3)

Positions 1 and 2 of the SW3 switch set the boot mode of the processor, as
described in Table 2-5. Position 3 sets the processor’s PLL on boot—

when the position is ON, the PLL is in bypass.

ADSP-BF561 EZ-KIT Lite Evaluation System Manual
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Jumper and DIP Switch Settings

Table 2-5. Boot Mode Select Switch (SW3)

Position 1 BMODEO Position 2 BMODE1 Boot Mode

ON ON Execute from 16-bit external
memory
(Bypass Boot ROM)

OFF ON Boot from 8-bit/16-bit flash
(defaulr)

ON OFF Boot from SPI host slave mode

OFF OFF Boot from SPI serial EEPROM
(16-, 24-bit address range)

Push Button Enable Switch (SW4)

Positions 1 through 4 of the push button enable switch (Sw4) allow to dis-
connect the drivers associated with the push buttons from the PF pins of
the processor. Positions 5 and 6 connect the transmit and receive frame
syncs and clocks of SPORTO. This is important when the AD1836A audio
codec and the processor are communicating in 2-wire interface (TW1I)
mode. Table 2-6 shows which PF is driven when the switch is ON.

Table 2-6. Push Button Enable Switch (SW4)

Switch Position  |Default Setting  |Pin # Signal (Side 1) [Pin# |Signal (Side 2)
1 ON 1 SW6 12 PF5

2 ON 2 SW7 11 PF6

3 ON 3 SW8 10 PF7

4 ON 4 SW9 9 PF8

5 OFF 5 TFSO 8 RFSO

6 OFF 6 RSCLKO 7 TSCLKO
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PPl Clock Select Switch (SW5)

The sw5 switch controls a clock selection of the PPI interfaces as described
in Table 2-7 and Table 2-8.

Table 2-7. PPICLK1 Clock Source Setup

SW5 Position 1 SW5 Position 2 PPIxCLKI1 Source
PPI0_CKSELO PPIO_CKSEL1

ON ON 27 MHz oscillator (default)
OFF ON ADV7183 clock out

X OFF Expansion interface

Table 2-8. PPICLK2 Clock Source Setup

SW5 Position 3

SW5 Position 4 PPICLK2 Source
PPI1_CKSELO

PPI1_CKSEL1

ON ON 27 MHz oscillator (default)
OFF ON ADV7183 clock out
X OFF

Expansion interface

Test DIP Switches (SW10 and SW11)

Two DIP switches (SW10 and SW11) are located on the bottom of the

board. The switches are used only for testing and should remain in the 0FF
position.

Audio Enable Switch (SW12)

The audio enable switch (SW12) disconnects the audio signals from the
processor. The default is all positions ON.
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SPIS1/SPISS Select (SW13)

The SP1S1/SPISS select switch (SW13) disconnects the SPIS1 and SPISS sig-
nals from the board, making them available on the SPI connector (P5).
The default is the ON position.

Video Encoder Clock Select Jumper (JP1)

The video encoder clock select jumper (JP1) determines the source of the
ADV7179 video encoder’s clock. The jumper setting is shown in
Table 2-9.

Table 2-9. Video Encoder Clock Select Jumper (JP1)

JP1 Position Mode

1and 2 Input clock for encoder is generated from 27 MHz oscillator (default)

2 and 3 Input clock for encoder is generated from output clock of decoder. This is
used when synchronizing the encoder and decoder clock is required.

VDDINT Select Jumpers (JP2 and JP3)

The processor internal voltage (VDDINT) select jumpers (JP2-3) determine
the source of the processor’s internal voltage. For the core clock set at
533 MHz and higher, select the on-board external regulator for VDDINT.
The jumper settings are shown in Table 2-10.

Table 2-10. Processor Internal Voltage Select Jumpers (JP2 and JP3)

JP2 JP3 VDDINT Source

Not populated 1 and 2 ON Provided by the on-board external regulator

Populated 2 and 3 ON Provided by the processor through the VROUT pins
(internal regulator)
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ADSP-BF561 EZ-KIT Lite Hardware Reference

UART Loop Jumper (P1)

The UART loop jumper (P1) is for looping the transmit and receive sig-
nals. The default is the OFF position.

LEDs and Push Buttons

This section describes functionality of the LEDs and push buttons.
Figure 2-3 shows the locations of the LEDs and push buttons.
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Figure 2-3. LED and Push Button Locations
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LEDs and Push Buttons

Reset Push Button (SW1)

The RESET push button resets all of the ICs on the board. One exception is
the USB interface chip (U34). The chip is not being reset when the push

button is pressed after the USB cable has been plugged in and communi-
cation with the PC has been initialized correctly. Once communication is
initialized, the only way to reset the USB is by powering down the board.

Programmable Flag Push Buttons (SWé-9)

Four push buttons, SW6-9, are provided for general-purpose user input.
The buttons connect to the programmable flag pins of the processor (PF5-
8). The push buttons are active high and, when pressed, send a high (1) to
the processor. Refer to “LEDs and Push Buttons” on page 1-14 for more
information on how to use PFs when programming the processor. The
push button enable switch (SW4) is capable of disconnecting the push but-
tons from its associated PF (refer to “Push Button Enable Switch (SW4)”
on page 2-12). The programmable flag pins and corresponding switches
are shown in Table 2-11.

Table 2-11. Programmable Flag Switches

Processor Programmable Flag Pin Push Button Reference Designator
PF5 SW6
PF6 SW7
PF7 SW8
PF8 SW9

Power LED (LED1)

When LED1 is lit (green), it indicates that power is being supplied to the
board properly.
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ADSP-BF561 EZ-KIT Lite Hardware Reference

Reset LED (LED2)

When LED? is lit, it indicates that the master reset of all major ICs is
active.

USB Monitor LED (ZLED3)

The USB monitor LED (ZLED3) indicates that USB communication has
been initialized successfully and you can connect to the processor using an
EZ-KIT Lite session. This takes approximately 15 seconds. If the LED
does not light, try cycling power on the board and/or reinstalling the USB
driver.

When the development software is actively communicating with
the EZ-KIT Lite target board, the LED can flicker, indicating
communications handshake.

User LEDs (LED5-12, LED13-20)

Sixteen LEDs connect to the processor’s programmable flags. Eight LEDs
labeled LEDS through LED12 are controlled by programmable flags PF40
through PF47 (equivalent to PP10_D15-8). Eight LEDs labeled LED13
through LED20 are controlled by programmable flags PF32 through PF39
(equivalent to PPI1_D15-8). To learn how to use the LEDs, refer to “LEDs
and Push Buttons” on page 1-14.

Table 2-12. User LEDs

LED Reference Designator |Flag Port Name |LED Reference Designator |Flag Port Name
LEDS PB40 LEDI3 PB32
LED6 PB41 LED14 PB33
LED7 PB42 LED15 PB34
LED8 PB43 LED16 PB35
LED9 PB44 LED17 PB36

ADSP-BF561 EZ-KIT Lite Evaluation System Manual 2-17



Connectors

Table 2-12. User LEDs (Cont’d)

LED Reference Designator |Flag Port Name |LED Reference Designator |Flag Port Name

LEDIO PB45 LED18 PB37

LEDII PB46 LEDI9 PB38

LED12 PB47 LED20 PB39
Connectors

This section describes the connector functionality and provides informa-

tion about mating connectors. The connector locations are shown in
Figure 2-4.
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Figure 2-4. Connector Locations
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Expansion Interface (J1-3)

Three board-to-board connector footprints provide signals for most of the
processor’s peripheral interfaces. The connectors are located at the bottom
of the board. For more information about the interface, see “Expansion

Interface” on page 2-8. For the availability and pricing of the J1, J2, and
J3 connectors, contact Samtec.

Part Description

Manufacturer

Part Number

90-position 0.05" spacing, SMT
(J1,3d2, 33)

SAMTEC

SFC-145-T2-F-D-A

Mating Connector

90-position 0.05” spacing SAMTEC TFM-145-x1 series
(through hole)
90-position 0.05” spacing SAMTEC TFM-145-x2 series
(surface mount)
90-position 0.05” spacing SAMTEC TFC-145 series
(low cost)
Audio (J4 and J5)
Part Description Manufacturer Part Number
2x2 RCA jacks (J4) SWITCHCRAFT PJRAS2X2S01X
3x2 RCA jacks (J5) SWITCHCRAFT PJRAS3X2S01X
Mating Connector
Two channel RCA interconnect MONSTER CABLE BI100-1M

cable

ADSP-BF561 EZ-KIT Lite Evaluation System Manual
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Connectors

Video (J6)

Part Description Manufacturer Part Number

3x2 RCA jacks (J6)

SWITCHCRAFT PJRAS3X2S01X

Power (J7)

The power connector provides all of the power necessary to operate the

EZ-KIT Lite board.

Part Description Manufacturer Part Number
2.5 mm power jack (J7) SWITCHCRAFT RAPC712X
Mating Power Supply (shipped with EZ-KIT Lite)
7V power supply CUI INC. DMS070214-P6P-SZ

The power connector supplies DC power to the EZ-KIT Lite board.
RS-232 (P2)

Part Description Manufacturer Part Number

DBY, male, right angle (P2) TYCO 5747250-4
Mating Assembly

2m female-to-female cable DIGI-KEY AE1016-ND
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SPORT1 (P3)

The SPORT1 connector is linked to a 20-pin connector. The connector’s
pinout can be found in “ADSP-BF561 EZ-KIT Lite Schematic” on
page B-1.

Part Description Manufacturer Part Number
IDC header ECI 68737-420HLF
Mating Connectors
IDC socket DIGI-KEY S4210-ND
SPI (P5)

The SPI connector is linked to a 12-pin connector. The connector’s pin-

out can be found in “ADSP-BF561 EZ-KIT Lite Schematic” on page B-1.

Part Description Manufacturer Part Number

IDC header SULLINS GECO06DAAN
Mating Assembly

IDC socket DIGI-KEY S$4207-ND

USB Debug Agent Connector (ZJ1)

The USB debug agent connector is the connecting point for the JTAG
USB debug agent interface. The JTAG header (zP4) should not be used
whenever 7J1 and its mating cable are used to communicate to the proces-

sor via CCES or VisualDSP++.
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Connectors

JTAG (ZP4)

The JTAG header is the connecting point for a JTAG in-circuit emulator
pod. When an emulator connects to the JTAG header, the USB debug

interface is disabled.

Pin 3 is missing to provide keying. Pin 3 in the mating connector

should have a plug.

When using an emulator with the EZ-KIT Lite board, follow the
connection instructions provided with the emulator.
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A ADSP-BF561 EZ-KIT LITE BILL

OF MATERIALS

The bill of materials corresponds to “ADSP-BF561 EZ-KIT Lite Sche-

matic” on page B-1.

Ref. | Qty. | Description Reference Designator | Manufacturer | Part Number

1 1 74LVC14A U47 TI 74LVC14AD
SOIC14

2 2 IDT74FCT3244 | U13,U30 IDT IDT74FCT3244APYG
APY SSOP20

3 1 12.288MHZ U16 EPSON SG-8002CA MP
0OSC003

4 1 NDS8434A SO-8 | U29 FAIRCHILD NDS8434A

5 2 MT48LC16M16 | U32-33 MICRON MT48LC16M16A2P-75
A2TG-75
TSOP54

6 1 27MHZ OSC003 | U17 EPSON SG-8002CA MP

7 2 IDT2305-1DC U19-20 INTE- ICS9112AM-16LFT
SOICS8 GRATED SYS

8 1 SN74LVC1G32 uU10 TI SN74LVC1G32DBVR
SOT23-5

9 1 30MHZ OSC003 | Ul4 EPSON SG-8002CA MP

10 1 BF561 uU27 ST MICRO M29W640DT 90NGE
M29W640D
"U27"

11 2 FDC658P U28,U49 FAIRCHILD FDC658P
SOT23-6
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Ref. | Qty. | Description Reference Designator | Manufacturer | Part Number
12 |1 ADM708SARZ U46 ANALOG ADM708SARZ
SOICS8 DEVICES
13 1 ADP3338AKCZ- | VR3 ANALOG ADP3338AKCZ-3.3-RL
33 SOT-223 DEVICES
14 |1 ADP3339AKCZ- | VR1 ANALOG ADP3339AKCZ-5-R7
5 SOT-223 DEVICES
15 |1 ADP3336ARMZ | VR2 ANALOG ADP3336ARMZ-REEL7
MSOP8 DEVICES
16 1 10MA D1 ANALOG AD1580BRTZ-REEL7
AD1580BRTZ DEVICES
SOT23D
17 | 4 ADG752BRTZ U22-23,U25-26 ANALOG ADG752BRTZ-REEL
SOT23-6 DEVICES
18 |3 ADB8061ARTZ U1-3 ANALOG ADB8061ARTZ-R2
SOT23-5 DEVICES
19 |1 ADM3202ARNZ | U21 ANALOG ADM3202ARNZ
SOIC16 DEVICES
20 8 ADB8GO6GARZ U5-7,U9,U11-12, ANALOG ADB8GOGARZ
SOIC8 U18,U24 DEVICES
21 1 ADI1836AASZ Ul15 ANALOG AD1836AASZ
MQEFP52 DEVICES
22 1 ADSP-BF561SK | U48 ANALOG ADSP-BF561SKBCZ-6V
BCZ MBGA256 DEVICES
23 |1 ADV7179KCPZ | U8 ANALOG ADV7179KCPZ
LECSP40 DEVICES
24 |1 ADV7183BKSTZ | U4 ANALOG ADV7183BKSTZ
LQFP80 DEVICES
25 |2 ADP1864AUJZ VR5-6 ANALOG ADP1864AUJZ-R7
SOT23-6 DEVICES
26 |5 RUBBER FOOT | M1-5 MOUSER 517-S]-5018BK

A-2
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Ref. | Qty. | Description Reference Designator | Manufacturer | Part Number

27 1 PWR J7 SWITCH- RAPC712X
2.5MM_JACK CRAFT
CONO005

28 1 RCA 2X2 J4 SWITCH- PJRAS2X2S01X
CONO013 CRAFT

29 5 MOMENTARY SW1,SW6-9 PANASONIC | EVQ-PAD04M
SWTO013

30 |3 .05 45X2 J1-3 SAMTEC SFC-145-T2-F-D-A
CONO019

31 3 DIP6 SWTO017 SW2,8W4,SW10 CTS 218-6LPST

32 2 RCA 3X2 J5-6 SWITCH- PJRAS3X2S01X
CONO024 CRAFT

33 | 4 DIP4 SWT018 SW3,SW5,SW11-12 | ITT TDA04HOSBI

34 1 DIP2 SWT020 SW13 C&K CKN9064-ND

35 1 IDC 2X1 P1 FCI 90726-402HLF
IDC2X1

36 1 IDC 2X1 Jjp2 FCI 90726-402HLF
IDC2X1

37 |2 IDC 3X1 JP1,JP3 FCI 90726-403HLF
IDC3X1

38 |1 IDC 10X2 P3 BURG-FCI 54102-T08-10LF
IDC10X2

39 | 4 IDC SJ1-4 DIGI-KEY S§9001-ND
2PIN_JUMPER _
SHORT

40 |1 DB9 9PIN P2 TYCO 5747250-4
DBIM

41 1 IDC 6X2 P5 FCI 68737-412HLF
IDC6X2

42 1 SA RESETABLE | F1 MOUSER 650-RGEF500
FUS005
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Ref.

Description

Reference Designator

Manufacturer

Part Number

43

14

0 1/4W 5% 1206

R43-44,R55,R71,
R73,R83,R133,
R159,R163,R223-
225,R247,R257

KOA

0.0ECTRk7372
BTTED

44

16

YELLOW
LEDO001

LED5-20

PANASONIC

LN1461C

45

12

330PF 50V 5%
0805

C82,C84,C86,
C92-100

AVX

08055A331JAT

46

48

0.01UF 100V
10% 0805

C3,C5,C28,C41,
C49,C69-70,C74-75,
C101,C112-114,
C127,C134,C136-
138,C140-141,C146,
C149-150,C154,
C156-157,C165-166,
C168,C173-174,
C176,C181-182,
C185-188,C190,
C192-194,C200-203,
C249,C256

AVX

08051C103KAT2A

47

0.22UF 25V 10%
0805

C104,C106-108,
C125,C129,C143,
C162

AVX

08053C224KAT2A
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Ref. | Qty. | Description Reference Designator | Manufacturer | Part Number
48 69 0.1UF 50V 10% C1-2,C4,C12,C19- AVX 08055C104KAT
0805 20,C22,C27,C29-30,
C35,C37,C48,C51-
52,C54-60,C65-66,
C71,C73,C83,C85,
C87-91,C102,C109-
111,C115,C122-124,
C126,C131-132,
C135,C139,C145,
C147-148,C151-152,
C155,C158-159,
C164,C167,C171-
172,C175,C177-179,
C183-184,C189,
C191,C196,
C198-199
49 | 10 | 1000PF 50V 5% | C23,C25,C33,C36, | AVX 08055A102JAT2A
0805 C38-40,C67-68,
C133
50 3 10UF 16V 10% CT17,CT23-24 SPRAGUE 293D106X9016C2TE3
C
51 43 10K 1/10W 5% R2,R7,R11-12,R14, VISHAY CRCW080510K0
0805 R24,R42,R45-47, JNEA
R52,R57,R85,R87-
88,R98,R131,R143,
R158,R160-162,
R167-170,R174-177,
R181-183,R189-190,
R196,R229,R239,
R246,R248-251
52 19 33 1/10W 5% R39,R41,R59-61, VISHAY CRCW080533R0
0805 R165-166,R171-172 JNEA
53 | 2 47K 1/10W 5% | R86,R90 VISHAY CRCW08054K70
0805 JNEA
54 |1 1.5K 1/10W 5% | Rl VISHAY CRCW08051K50
0805 FKEA
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Ref. | Qty. | Description Reference Designator | Manufacturer | Part Number

55 1 1.2K 1/8W 5% R23 VISHAY CRCW12061K20
1206 JNEA

56 6 49.9K 1/8W 1% R108-113 VISHAY CRCW120649K9
1206 FKEA

57 12 100PF 100V 5% | C6-11,C26,C34, AVX 12061A101JAT2A
1206 C61-63,C72

58 6 10UF 16V 10% B | CT1-4,CT15-16 AVX TAJB106K016R

59 | 4 100 1/10W 5% R242-245 VISHAY CRCW0805100
0805 RJNEA

60 6 220PF 50V 10% | C13-18 AVX 12061A221JAT2A
1206

61 4 600 100MHZ FER18-21 DIGI-KEY 490-1014-2-ND
200MA 0603

62 1 2A S2A D7 VISHAY S2A-E3
DO-214AA

63 12 600 100MHZ FER2-4,FERG,FER8- | STEWARD HZ1206B601R-10
500MA 1206 12,FER14-16

64 | 4 237.0 1/8W 1% | R25-26,R53-54 VISHAY CRCW1206237
1206 RFKEA

65 | 4 750.0K1/8W 1% | R132,R156,R164, VISHAY CRCW1206750
1206 R173 KFKEA

66 16 5.76K 1/8W 1% R8,R15-16,R40,R49- | VISHAY CRCW12065K76
1206 50,R58,R62-64,R69- FKEA

70,R121-124

67 6 11.0K 1/8W 1% R144-149 VISHAY CRCW120611K0
1206 FKEA

68 8 120PF 50V 5% C103,C105,C128, AVX 12065A121JAT2A
1206 C130,C142,C144,

C161,C163

69 12 | 75 1/8W 5% R4-6,R100-102, VISHAY CRCW120675R0

1206 R104-105,R107, JNEA

R114,R134-135

ADSP-BF561 EZ-KIT Lite Evaluation System Manual




ADSP-BF561 EZ-KIT Lite Bill Of Materials

Ref. | Qty. | Description Reference Designator | Manufacturer | Part Number

70 1 68UF 6.3V CT22 AVX TAJD686KO016R
20% D

71 6 680PF 50V 1% C116-121 AVX 08055A681FAT2A
0805

72 | 5 10UF 25V C31,C47,C50,C195, | DIGI-KEY 587-1393-2-ND
+80-20% 1210 C197

73 | 6 2.74K 1/8W 1% | R150-155 VISHAY CRCW12062K74
1206 FKEA

74 | 12 | 5.49K 1/8W 1% | R17-22,R27,R30-31, | VISHAY CRCW12065K49
1206 R34-35,R38 FKEA

75 6 3.32K 1/8W 1% R137-142 VISHAY CRCW12063K32
1206 FKEA

76 6 1.65K 1/8W 1% R28-29,R32-33,R36- | VISHAY CRCW12061K65
1206 37 FKEA

77 10 10UF 16V 20% CT5-14 PANASONIC | EEE1CAI100SR
CAPO002

78 1 10UH 20% L11 TDK 445-2014-1-ND
INDO001

79 6 0 1/10W 5% R66,R99,R103, VISHAY CRCW08050000
0805 R106,R178,R192 Z0EA

80 1 190 100MHZ 5A | FER22 MURATA DLW5BSN191SQ2
FER002

81 4 22 1/10W 5% R67-68,R187-188 VISHAY 541-22ATR-ND
0805

82 6 0.68UH 10% L1-4,16,L8 MURATA LQM21NNRG68K10D
0805

83 1 .082UF 50V 5% Co64 AVX 08055C823JAT2A
0805

84 |1 1A ZHCS1000 D5 ZETEX ZHCS1000TA pb-free
SOT23-312

8 |3 2.2UH 10% 0805 | L5,L7,L9 DIGI-KEY 490-1119-2-ND
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Ref. | Qty. | Description Reference Designator | Manufacturer | Part Number

86 3 1UF 10V 10% C21,C24,C32 AVX 0805ZC105KAT2A
0805

87 1 76.8K1/10W 1% | R48 VISHAY CRCW120676K8
1206 FKEA

88 1 147.0K 1/10W R56 VISHAY CRCW1206147
1% 1206 KFKEA

89 | 10 | 10 62.5MW 5% | RNI,RN4-12 PANASONIC | EXB-38V100]JV
RNS006

90 2 68PF 50V 5% C160,C257 AVX 06035A680JAT2A
0603

91 2 470PF 50V 5% C153,C258 AVX 06033A471JAT2A
0603

92 2 0 1/10W 5% R74,R254 PHYCOMP 232270296001L
0603

93 2 249K 1/10W 1% | R72,R256 DIGI-KEY 311-24.9KHTR-ND
0603

94 2 10UF 16V 10% C169,C260 AVX 1210YD106KAT2A
1210

95 |1 680 1/8W 5% R119 VISHAY CRCW1206680RFNEA
1206

96 1 150.0 1/8W 1% R3 VISHAY CRCW1206150RFKEA
1206

97 1 GREEN LEDO001 | LED1 PANASONIC | LN1361CTR

98 1 RED LEDO001 LED2 PANASONIC | LN1261CTR

929 2 1000PF 50V 5% | C43,C46 AVX 12065A102]JAT2A
1206

100 | 6 2200PF 50V 5% C76-81 AVX 12065A222]JAT050
1206

101 | 6 1K 1/8W 5% R10,R115-118,R136 | VISHAY CRCW12061K00
1206 FKEA
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ADSP-BF561 EZ-KIT Lite Bill Of Materials

Ref. | Qty. | Description Reference Designator | Manufacturer | Part Number

102 | 2 100K 1/8W 5% R9,R13 VISHAY CRCW1206100K
1206 FKEA

103 | 17 270 1/8W 5% R120,R213-220, VISHAY CRCW1206270
1206 R230-237 RJNEA

104 | 6 604.0 1/8W 1% R125-130 VISHAY CRCW1206604R
1206 FKEA

105 | 4 1UF 20V 20% A | CT25-28 AVX TAJA105K020R

106 | 1 255.0K 1/10W R89 VISHAY CRCW06032553FK
1% 0603

107 | 2 80.6K1/10W 1% | R80,R255 DIGI-KEY 311-80.6KHRCT-ND
0603

108 | 2 6.8UH 25% L10,L12 DIGI-KEY 308-1328-1-ND
INDO009

109 | 2 4A SSB43L D4,D8 VISHAY SSB43L
DO-214AA

110 | 2 S5A D2-3 ON SEMI MBRS540T3G
MBRS540T3G
SMC

111 |1 0.027 1/2W 1% R79 SUSUMU RL1632T-R027-F-N
1206

112 | 1 549K 1/10W 1% | R252 VISHAY CRCW060354K9
0603 FKEA

113 | 1 0.047 1/2W 1% R253 SUSUMU RL1632S-R047-F
1206

114 | 2 100UF 6.3V CT19,CT29 SANYO 6TPB100MC
20%C
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| INDEX

Numerics

2-wire interface (TWI) mode, 1-15, 1-17,
2-12

A

A25-2 address bus pins, 2-3
AD1836A audio codecs, 1-15, 2-3, 2-4,
2-12
ADV7179 video encoders
video interface, 1-16
clock select jumper (JP1), 2-14
configuration switch (SW2), 2-10
PPI1 interface, 2-6, 2-7
programmable flags, 2-4
reset, 1-16
ADV7183A video decoders
video interface, 1-16
clock select switch (SW5), 2-13
configuration switch (SW2), 2-10
PPIO interface, 2-6, 2-7
programmable flags, 2-4
reset, 1-16
AIN1/4/5 analog video channels, 2-7
AMSO0 memory select pins, 1-12
analog
audio interface, See SPORTO0
video interface, See video interface
architecture, of this EZ-KIT Lite, 2-2
ASYNC (asynchronous memory control)
banks, 1-11

audio
codecs, See AD1836A
connectors (J4-5), 2-19
enable switch (SW12), 2-13
interface, See SPORT

B

bill of materials, A-1

BMODEI1-0 (boot mode select) pins, 2-12
board design database, 1-17

board schematic (ADSP-BF561), B-1

boot mode select switch (SW3), 2-11

C

clock select switch, of PPIs (SW5), 2-13
codecs, See AD1836A
configuration, of this EZ-KIT Lite, 1-3
connectors

diagram of locations, 2-18

DB9 (UART), xii, 2-8

J1-3 (expansion), 2-8, 2-19

J4-5 (audio), 2-19

J6 (video), 2-20

J7 (power), 2-20

P2 (RS-232), xi, 2-20

P3 (SPORT1), 2-3, 2-21

P5 (SPI), 2-3, 2-14, 2-21

P9 (SPORTO0), 2-21

ZJ1 (USB), 1-5, 2-21

ZP4 (JTAG), 2-22
contents, of this EZ-KIT Lite package, 1-2
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Index

core
clock rate, 2-2, 2-14
frequency, 1-14
voltage, 2-2

D

DAC A/B/C analog audio channels, 2-7
DB9 (UART) connector, xii, 2-8, 2-20
default configuration, of this EZ-KIT Lite,

1-3
DIP switches
diagram of locations, 1-3, 2-10
SW10-11 (test), 2-13
SW2 (video config), 1-16, 2-8

SW4 (push button enable), 1-15, 2-12,

2-16

E

EBIU
address bus (A25-2) pins, 2-3
control signals, 2-3, 2-8
EBIU_SDBCTL register, 1-13, 1-14
EBIU_SDGCTL register, 1-13, 1-14
EBIU_SDRRC register, 1-13, 1-14
evaluation license
CCES, 1-10
example programs, 1-18
expansion interface, 2-3, 2-8, 2-19
external bus interface unit, See EBIU
external memory
See also flash memory, SDRAM
memory map, 1-11
via JTAG, 2-9
EZ-KIT Extender boards, 2-6

F

features, of this EZ-KIT Lite, xi
FIELD (ADV7183A) control signal, 2-4,
2-8,2-11

FIOO0_FLAG_D registers, 1-15
FIO2_DIR register, 1-14
FIO2_FLAG_C/D/S/T registers, 1-14
flag pins, See programmable flags (PFs)
flash

memory, 2-3

ports (PB47-32), 2-17
frequency, 1-13, 1-14

G

general-purpose 1O pins, 1-14, 2-4, 2-12,
2-16

GND signals, 2-8

H
HSYNC signals, 2-6, 2-7

I
input clocks, 1-16, 2-2, 2-5, 2-7
installation, of this EZ-KIT Lite, 1-8
CCES, 1-4
interfaces, See video, SPORTO, SPI,
expansion
internal memory
See also SRAM
map of the processor, 1-12
internal voltage (VDDINT), 2-14
IO voltage, 2-2
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J

JTAG
connector (ZP4), 2-9, 2-22
emulation port, 2-9

jumpers
JP1 (ADV7179 clock select), 2-14
JP2-3 (VDDINT source select), 2-14
P1 (UART loop), 2-15

L

LEDs
diagram of locations, 1-3, 2-15
LED13-20 (PF39-32), 1-14, 2-5, 2-17
LED1 (power), 2-16
LED2 (chip reset), 2-17
LED5-12 (PF47-40), 1-14, 2-5, 2-17
ZLED3 (USB monitor), 1-8, 2-17

M
Media Instruction Set Computing (MISC),

ix
memory
map, of this EZ-KIT Lite, 1-11
select pins, See AMS2-0, SMSO
Micro Signal Architecture (MSA), ix

N

notation conventions, xviii

@)

OE (ADV7183A) signal, 2-4, 2-10
oscillators, 2-6, 2-7, 2-13

p

P3 (SPORTO) connector, 2-3
package contents, 1-2

Index

parallel peripheral interfaces (PPIs), 1-17,
2-5, 2-10, 2-19
See also PP10, PPI1
PB47-32 flash ports, 2-17
power
connector (J7), 2-20
LED (LED1), 2-16
PPI0O_D15-8 bits, 1-14, 2-5
PPIO interface
to ADV7183A decoder, 1-16, 2-7
clock select pin, 2-6, 2-7
D15-8 bits, 2-17
D7-0 bits, 2-6
SYNC2-1 Signals, 2-6,2-8, 2-11
PPI0O_SYNC2-1 synchronization signals,
2-8,2-11
PPI1_D15-8 bits, 1-14, 2-5
PPI1 interface
to ADV7179 video encoder, 1-16, 2-7
clock select pin, 2-7
D15-8 bits, 2-17
D7-0 bits, 2-6, 2-7
HSYNC signals, 2-7
SYNC2-1 signals, 2-7, 2-11
PPI clock select switch (SW5), 1-16, 2-13
PPIxCLK signals, 2-13
product information, xvi
programmable flags (PFs)
connections, 2-4
PFO (video serial clock), 1-17, 2-4
PF1 (video serial data), 1-17, 2-4
PF2 (DV7183A enable), 1-17, 2-4, 2-10,
2-11
PF3 (ADV7183A field pin), 2-4, 2-8,
2-11
PF4 (AD1836A SPI select), 1-15, 2-3,
2-4
PF13 (ADV7183A reset), 1-16, 2-4
PF14 (ADV7179 reset), 1-16, 2-5
PF15 (AD1836A reset), 1-16, 2-5
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Index

programmable flags (PFs) (continued)
PF16-20 (SPORTO0), 2-5
PF21-25 (SPORT1), 2-5
PF26-27 (UART), 2-5
PF28-29 (SPORTO serial clock), 2-5
PF30-31 (SPORT1 serial clock), 2-5
PF39-32 (LED13-20), 2-5
PF47-40 (LED5-12), 1-14, 2-5
PF5-8 (general-purpose 10), 1-14, 2-4,

2-12,2-16

pull-down resistors, 1-16

pull-up resistors, 2-11

push buttons
See also switches by name (SWx), 1-14
diagram of locations, 2-15
enable switch (SW4), 2-12

R

RCA jacks, xi, 2-19
Reduced Instruction Set Computing
(RISC), ix
related documents, xviii
reset
audio codec, 1-16
LED (LED2), 2-17
processor, 1-13
push buttons switch (SW1), 2-16
USB interface, 2-16
video encoder/decoder, 1-16, 2-4
RESO signal, 1-15, 2-12
RS-232 connector (P2), xi, 2-8
RSCLKO signal, 1-15, 2-12

S

schematic, of ADSP-BF561 EZ-KIT Lite,
B-1
SDRAM memory
connections, 2-3
control registers, 1-12

SDRAM memory (continued)
core MMRs, 1-12
data bank B SRAM, 1-12
data banks A, B SRAM, 1-12
default settings, 1-13
instruction SRAM, 1-12
instruction SRAM/CACHE, 1-12
optimum settings, 1-14
reserved, 1-12
scratch pad SRAM, 1-12
system MMRs, 1-12
serial
clock pin (SCL), 1-17, 2-4
data pin (SDAT), 1-17
video data, 2-4
serial peripheral interface (SPI), 2-3, 2-4,
2-14
setup, of this EZ-KIT Lite, 1-4
SMS0 memory select pins, 1-12
SPIS1/SPISS signals, 2-14
SPORT
audio interface, 2-3
SPORTO
audio interface, xii, 1-15
connector (P3), 2-21
receive data secondary pin (PF20), 2-5
receive frame sync pin (PF19), 2-5
receive serial clock pin (PF28), 2-5
transmit data primary pin (PF18), 2-5
transmit data secondary pin (PF17), 2-5
transmit frame sync pin (PF16), 2-5
transmit serial clock pin (PF29), 2-5
SPORT1
receive data secondary pin (PF25), 2-5
receive frame sync pin (PF24), 2-5
receive serial clock pin (PF29), 2-5
transmit data primary pin (PF23), 2-5
transmit data secondary pin (PF22), 2-5
transmit frame pin (PF21), 2-5
transmit serial clock pin (PF31), 2-5
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SRAM data bank A, 1-12
startup, of this EZ-KIT Lite, 1-8
CCES, 1-4
SW10-11 (test) DIP switches, 2-13
SW12 (audio enable) switch, 2-13
SW13 (SPIS1/SPISS select) switch, 2-14
SW1 (reset) push button, 2-16
SW2 (video config) DIP switch, 1-16, 2-6,
2-7,2-8,2-11
SW3 (boot mode) switch, 2-11
SW4 (push button enable) DIP switch,
1-15, 2-12, 2-16
SW5 (PPI clock select) switch, 1-16, 2-6,
2-13
SW6-9 (general input) push buttons, 1-14,
2-4,2-12, 2-16
synchronous dynamic random access
memory, See SDRAM
system
architecture, of EZ-KIT Lite, 2-2
clock (SCLK), 1-13

T

technical support, xv

test DIP switches (SW10-11), 2-13

TFSO signal, 1-15, 2-12

time-division multiplexed (TDM) mode,
1-15

timers11-8, 2-6

timers7-0, 2-4

TSCLKO signal, 1-15, 2-12

U

UART
loop jumper (P1), 2-15
port, xii, 2-8
transmit/receive pins (PF26-27), 2-5
universal asynchronous
receiver/transmitter, See UART port

Index

USB
cable, 1-2
connector (ZJ1, 1-5
debug agent connector (Z]1), 2-21
interface, 2-9, 2-16, 2-22
monitor LED (ZLED3), 2-17
user LEDs (LED5-12, LED13-20), 2-17

\Y%

VDDINT signal, 2-14
very-long instruction word (VLIW), ix
video
channels, 2-7
configuration switch (SW2), 2-10
connector (J6), 2-20
control signals, 2-7, 2-8
decoders, See ADV7183A
encoders, See ADV7179
input (PPI0), 2-7
interface, 1-16
output (PPI1), 2-7
Visual DSP++
environment, 1-8
VROUT pins, 2-14
VSYNC signals, 2-6, 2-7
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